
I imported an ASCII file and all mv fields are mixed up! 

The order of the fields in the file to be imported must be the same as the 

order of fields in AFS: Header, First name, Last name, Title, Company, Ad­

dressl, Address2, Address3, City, State, Zip, Country, Phonel, Phone2, Memo. 

Also, if you have fields missing on the ASCII file (for example, there is no 

Company field) then be sure and deselect those fields from the window that ap­

pears when you attempt to import an ASCII file. 

I made some changes to one of mv entries using the List 
Editor window. but the address hasn't changed in the list 
window! 

You forgot to press the 'Change' button on the list editor window after 

finishing your changes. If you haven't closed the List Editor window, go to it by 

pulling down the windows menu and selecting List Editor. If you see the entry 

you modified displayed there on the list editor window, along with the changes 

you've made, then press the 'Change' button. Otherwise, you will have to make 

the changes again - and be sure to press the 'Change' button. 
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Reference 
Mv address won't fit inside the label! 

First, choose the "Show Cell Boundaries" from· the layout menu. Next, 

from the layout window, select the address by using the mouse and dicking on 

any portion of it and then dragging it so that it fits inside the label better. Also 

look at other cells to see how various addresses fit in the cells (i.e., some street 

addresses are longer than others). You can reposition your pictures in the same 

manner. It is a good idea to keep your pictures above or to the left of your ad­

dress field. This way you can be sure it won't be overwritten by a long address. 

After repositioning your address, if it still does not fit you might consider 

changing the font size. Keep in mind that ornate fonts will be harder to read as 

the font size becomes smaller so you might consider using a plain font when 

choosing a small size. 

The return address is not showing up on the layout window! 

Under the Elements menu, make sure that the "Return Address" item is 

checked. If this doesn't solve the problem then make sure that 'Clip Elements to 

Boundaries' is not checked in the Cells menu, and then see if the return address 

shows up outside the area of the label. If you still can't see a return address then 

make sure you have one defined. If the 'Return Address' item in the Elements 

menu is dimmed, then you do not have a return address defined. Go back to the 

list window to define a return address. 

I typed a very long name/address!citv!etc. and I can't see all 
of it in the list window! 

Use the left and right arrow keys to move past what you can currently see, and 

the field will 'scroll' as you do so. 
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Appendix A~Notes on Bulk Sorting 

AFS allows you to perform a bulk sort on your list so that you may rake advan­

tage of discounts offered by the United States Postal Service. Visit your nearest 

Post Office for full details and instructions on bulk sorting before you attempt to 

do a bulk sort mailing. There are rules and conditions that must be met in order 

to qualify for discounts, and your local Post Office can supply you with an the 

necessary paperwork. 

Appendix B-Troubleshooting 

Mv clip art disappeared from the lavout window!! 

You're clip art may be off the cell boundaries, in which case if the "Clip Ele­

ments to Boundaries" is checked, the dip art will not be displayed. If this is not 

the problem then it could be that the lines in the picture, when scaled down, re­

sult in them disappearing. Try a picture with thicker lines, or a smaller picture. 

Under the Cells menu, make sure that tbe "Clip Elements to Boundaries" 

item is not checked. To see where the cell boundaries are, make sure that under 

the Cells menu you have "Show Cell Boundaries" checked. 

The 'Choose Font' option is dimmed. what do I do? 

In order for this option to be active you must first select your address in 

the layout window by simply clicking on it You will see a gray rectangle appear 

around it. You can then 'Choose Font' 
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Addressed For Success 
The following menu items' field names correspond to the fields in every 

address. If the menu item field name is checked, then the fiel<;J will be displayed 

within the address. If not checkb:i, then it will be omitted. For example, small 

labels will not be able to fit an fields, so it is wise to uncheck Title, Company, 

Phone 1, and Phone 2. There is no Memo menu item because the Memo field, 

by its very nature, is too free-fonn and suggests no logical way to appear in a 

cell-formatted layout 

Header 

First Name 

Last Name 

Title 

Company 

Address 1 

Address2 

Address 3 

City 

State 

Zip 

Country 

Phone 1 

Phone2 
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Addressed For Success 
Welcome 

Thank you for purchasing Addressed For Success™! We hope that this product 

will help you achieve more out of your Apple Hgs system. Please be sure to re­

turn the registration card. By doing so, you'll be able to receive technical sup­

port and notices of future updates and products. AU suggestions, praise, and 

criticism regarding this, or any other Econ Technologies product, is welcomed. 

We set out. to develop an easy to use, desktop based address database and label­

ing program, something every Apple IIgs owner who makes labels can use. We 

are proud to bring Addressed For Success to the Hgs market and hope you wi.H 

benefit from its capabilities! 

What Addressed For Success Can Do 

Addressed For Success is a desktop address database and labeling program. Its 

primary intended use is for entering and storing addresses, and printing labels. 

1be best feature of AFS is the layout window, where you can define your labels, 

and see exactly how they will appear before you print. Since you can exactly 

define the dimensions of your labels, AFS will work with any label size. 

With a little imagination you can make AFS print much more than just address 

labels. You can use it to make disk labels, VCR tape labels, name badges, and 

much more. If you cannot find the exact size label you need, you can purchase 

labels that are basically one very large label per sheet, and cut out the labels to 

the desired size after they are printed. 

You can also use the database capabilities of AFS to print subsets of your li~t. 

For example, if you keep a list of all friends and relatives you may enter each 

person's birthday in the memo field, such as 'Bday Jan l ', 'Bday Dec 15', 

'Bday Jul 29'. At the end of November you can search your Hst for all addresses 

where the memo field contains 'Bday Dec' and print out these labels so you can 

send everyone whose birthday falls in December a birthday card. 

As you can see, the possible ways to use AFS are only limited by your imagina­

tion. 
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Address Menu 

Choose Font... 

This function is only available if either an address element or a return 

address element is selected in the layout window. To select either one simply 

dick on it You will see a gray rectangle appear around the selected item. After 

selecting 'Choose Font..' from the Address Menu you will see a dialog box dis­

played, which allows you to change the font of the selected list address or return 

address in the Layout window. The font change is applied to all the cells. Note 

that the list addresses and the return address can have different fonts. 

Display as UPPERCASE 

This option, when checked, displays all addresses as uppercase. This only 

affects the way the address is displayed, not stored in memory. This option was 

added to AFS because the United States Postal Service prefers uppercase ad­

dresses since they can be more easily sorted by their scanners, but lowercase is 

acceptable. Check with your local Post Office for more details. 

Display ZIP with +4 

This option, when checked, displays all United States addresses' ZIP 

codes with the +4 extension if there is not already a +4 extension present. Since 

AFS does not know what the correct extension is, it makes it '0000'. 1bis only 

affects the way the address is displayed, not stored in memory. The postal ser­

vice prefers ZIP+ 4 addresses because they can be more easily sorted by their 

scanners. Check with your local Post Office for more details. Note that when 

you choose this option, the barcodes will also increase in size and may not fit on 

your labels if the labels are small. Also, the barcodes that you see in the window 

are exactly what will appear on the printed page. 
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Addressed Success 
Scale Pictures ... 

This option allows you to scale and previevy pictures you have pasted 

into the AFS layout. First you must select the picture on your layout window by 

clicking on it, in order for the Scale Pictures ... option to become available to 

you. After you select 'Scale Pictures .. .' a large window shows up in the screen. 

The Preview section, located on the left side of the window, gives you a preview 

of the picture. The Scale section, located on the right hand side of the window, 

gives you two ed~t fields where you may enter lhe horizontal and vertical scaling 

desired. You can use the mouse to position the cursor or tab to go move from lhe 

firsl to the second edit field. 

Scale Pictures ... 
... PrevieN .................................................. . .. Scale ..................................... . 
1 ~m~ Happy iLrtni i I so 1% Horizontall11 ! 

( Preview ) 

( Cancel 

Figure 23. Scale your pictures and preview the results here. 
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What You Need 

Addressed For Success runs on an Apple Hgs with a minimum 1.5 mb of RAM, 

Finder 6.0 and System Software 6.0. If your computer is running an earlier ver­

sion than 6.0, you will need to upgrade to 6.0. Addressed For Success will NOT 

work with earlier versions. See your favorite Apple II dealer for the complete 

System Software 6.0 update. 

Installing Addressed For Success 

Installing Addressed For Success is very easy if you follow these steps: 

Installing in a system with two floppy drives or a hard 
drive 

l. Insert the Addressed For Success disk into your computer's disk drive. An 

application named AFSJnstall wm appear on your computer's desktop. 

2. N<?w launch the application AFS.InstaH by double clicking on its icon. See 

figure 1. 

3. The Addressed For Success installer will prompt you to enter your name and 

the name of your organization, as shown in figure 2. These names will get re­

corded permanently onto your Addressed For Success program, so choose some­

thing appropriate. 

~D~ Rm.vu ~El~ 
ProDOS 6 items 77 

fr 

AFSinst11l l 

Figure 1. This window shows up after the 

Addressed For Success disk is inserted in 

the disk drive. 
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H~JJMUeJ J 
• Please personalize your copy of 
• Addressed For Success'" by entering • your n(JDe and organization (if any) . • • Um name: II I • for • • Organization: [ J • • H Sacceu ) • ( Quit ) ( Canti nue ) • 

Figure 2. Enter the appropriate information at this screen. 

After entering your name and organization name (if applicable), press the Con­

tinue button. 

5. If you wish to quit the installation process, press the Quit button. 

Next, the dialog shown in figure 3 will prompt you to choose the volume where 

you want Addressed For Success, and the Avery Label Templates installed. By 

default, the startup volume of your GS will be listed. If you want to install Ad­

dressed For Success on a different volume, press the Next Disk button. You can 

continue to press the Next Disk button until the name of the desired volume is 

listed in the dialog. 

H~JJMned J 
• Install: • [81 Rddmed for Success Application • • [81 Avery Label Templates • • for • Onto Volume: 

H S««tU '10 J 
• •:sustemOne'" • • • ( Next Disk ) ( Quit ) ( Install ) • 

Figure 3. Choose the volume where you want Addressed For 

Success installed from this window. 
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Postal Bar Code 

This item, when checked, displays a postal bar code in every cell that has 

an United States address with a ZIP code. If an address has something in its 

Country field, then it is assumed the address is not United States and thus there 

will be no bar code. Barcodes for ZIPs that have 5 digits will fit most small la­

bels. However, ZIPs that have 9 digits exceed most small label widths. Be sure 

and do a visual check of your layout window to see that the postal bar codes will 
fit. 

I I 1I11111II11II11 , , , ,, , , , ,, , , , , , 

Figure 22. A typical postal bar code. 

Picture #1 

This item, when checked, displays picture #1 in each cell. In order to 

have a picture available to you in AFS you must copy if from another program, 

then go to AFS and while in the Layout window select paste from the Edit 

menu. Figures are numbered in the order in which they are pasted. 

Picture#2 

This item, when checked, displays picture #2 in each cell. See above for 
more details. 

Picture #3 

This item, when checked, displays picture #3 in each cell. See Picture #1 
for more details . 
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Cells Go Left to Right 

Selecting this option togg!es it on and off. If the option is on, then AFS 

will arrange the List's addresses so that they proceed from left to right, and then 

top to bottom along the page. 

Cells Go Top to Bottom 

This option, when checked, arranges the List's addresses so that they 

proceed from top to bottom, and then left to right along the page. 

Elements Menu 

The first five items in this menu are toggled on and off by selecting them. When 

an item is toggled on it will have a check mark to the left of it. If it is toggled 

off then it will not have a check mark. 

List Addresses 

This item, when checked, causes I.he List's addresses to be displayed, 

and therefore printable, in the Layout window. This option can be useful if you 

want to print a bunch of labels that you can use for return addresses in your cor­

respondence (such as on your bills). You would have List Addresses toggled 

off. and you would have a return address specified and toggled on (see follow­

ing). To make it even nicer you could paste a picture on these labels. 

Return Address 

This item, when checked, displays the List's one return address in every 

cell, in addition to the normal list address. Even though you have a return ad­

dress specified you still have a choice whether you want it to print or not by 

means of this option which can be toggled on or off. 
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Getting Started 
Once you've selected the desired location, press the Install button. Addressed 

For Suc<;:ess wm display the message shown in figure 4 once installation is c;om­

plete. Press the OK button and AFS will return to the previous window. You 

may install it on any other volume by performing the same steps again. When 

done press the Quit button. 

Installation onto the vollllle ":SijstemOne• has 
been successfullu completed! 

Figure 4. Addressed For Success displays this mes­

sage after a successful installation. 

Installing in a system with a single floppy drive 

1. Complete steps 1 - 4 from above. 

2. Press the Quit button. 

3. Now use your favorite disk copy utility to make a copy of the entire AFS disk. 

You can then run AFS off the duplicate disk. Never run AFS from the original 

disk - put it in a safe place in case your copy becomes damaged. 

A-5 



Reference 

Clip Elements to Boundaries 

Selecting this option toggles it on and off. If the option is checked/on, 

you will see a check mark to the left of it When checked, the layout window 

will not display any print that falls outside actual label, as defined by using the 

Set Cell Dimensions function. 

La~out.1 

Horiz: 0 01 O" Vert: O 01 O" 04' <?? <l>O 

Rick l\mieka 
5673 Oak Ridge Nfl 
Apt B 
l'nm~?n~~ Dor~ LIT AQ'.l?I 

l11ll1l11l1l11l111l1l111lll11l1I 

John-Paul Boisvert 
PO Box 459 
Aroory MS 38821 

Anders Bachman 
4882 Chiroineas Avenue 
Northridge CA 91325 

l1ll11ll111ll1111l11l1l1\11l1\1I 

Colleen Burbank 
12382 Beverly Place 
Lake Forest IL 60045 

Page: 1 of 2 

Figure 21. This is the same layout as shown in Figure 20, with Clip Elements to 

Boundaries toggled on. Notice that you need not have cen boundaries showing 

in order to clip the elements to boundaries. 

Note: If you cannot see an element, perhaps because you made the picture too 

large, or the font of the address is too large, or you've simply placed the ele­

ment outside the area of the cell, uncheck this option so that all elements will 

be visible even though they're "out-of-bounds." You can then select the ele­

ment by clicking on it on the layout window, and moving it with your mouse. If 

an address, you can select it by clicking on it. You could then use the Choose 

font option from your address menu and make the font smaller. In the case of a 

picture you can select H by clicking on it, and you could then move it or change 

its size (see the Elements menu item Scale Pictures ... ) 
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size you entered in the Set Cell Dimensions ... function. We suggest you keep 

this option check, siµce it is a valuable tool in viewing how your addresses fit to 

the labels. 

m la~out.1 

Horiz: 0 01 0" \lert: 0 01 0" ll1' 1'? ?O 

Rick Amieka 
5613 Oak Ridge NW 
Apt B 
GG!ffitoek·Park·Ml· 4n2+ 

Anders Bachman 
4882 Chimineas Avenue 
lbrthridge CA 91325 

Page: 1 of 2 
!ll111lll111ll1111ll1111fr 

!Fmi.ly Barr 
11896 10th 
fKenner LA 
I 
1... ....................................... . 

11ll1l11l1l11l111l1l111lll11l1I 
.......................................................................... ! i;K;ff1·;xi;;·;·;r;1I;r;r;;I;ir ·· ··· ........... ···· 

John-Paul Boisvert I 
PO Box 459 
Aroo MS 38821 

Colleen Burbank 
12382 Beverly Place 
I.&e Forest IL 60045 

Figure 19. The cell boundaries are showing. You can now clearly see that the 

address is too long and wm have to be modified. 

m layout.1 
Horiz: 0 01 0" Vert: 0 01 0" 01' <?? ?D 

Rick illnie ka 
S673 Oak Ridge NW 
Apt B 
Comstock Park MI 49321 
l1ill1l11l1l11l111lil111lll11l1I 

John-Paul Boisvert 
PO Box 459 
Aroory MS 38821 

An de rs Bae hman 
4882 Chimineas Avenue 
Northridge CA 91325 

l1ll11ll111ll1111l11l1\1!11l1l1I 

Colleen Burbank 
12382 Beverly Place 
Lake Forest IL 60045 

Figure 20. The cell boundaries are not showing. 
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Fields 

AFS is primarily designed to maintain a database of names and addresses and to 

allow easy printing of labels. As such, it gives you fifteen named fields for each 

entry of your database: 

1. Header 

2. First Name 

3. Last Name 

4. Title 

5. Company 

6. Address 1 

7. Address 2 

8. Address 3 

9. City 

10. State 

11. Zip 

12. Country 

13. Phone l 

14. Phone 2 

15. Memo 

Fields I through 14 are 'printable' fields. You can have AFS print any and all 

of these 'printable' fields. The memo field cannot be printed, and you will 

therefore never see it in the layout window. 

Cells 

This term is used in the layout window. Typically, your ceU will be the exact 

size of your label. You can define the size of your cell when working in the lay­

out window. We recommend that you define your cell to be the exact size of 

your label. That is, if you're using a roll of 3-1/2" x 15/16" labels, then your cell 

should be defined as a 3-1/2" x 15/16" rectangle. 
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Unmark Return Address 

Causes no return address to be specified. 

List Info ... 

Displays a dialog box with infonnation about the List, like the number 

of addresses, the number of selected addresses, the return address (shown by 

First and Last name), whether the list is postal bulk sorted, and the size of the 

list. 

list Info ... 

Addresses: 37 
Selected addresses: 1 

Return address: Hone 
Memory used: ~K 

List is bulk sorted: Ho 
Hisit bulk addresses: H/A 
3-Digit bulk oddrmes: NIA 

State bulk addmses: MIR 
Hixed states bulk addresses: H/A 

Non-USPS addresses: MIR 

( OK J 

Figure 16. A typical List Info dialog. 

View Menu 

25% Causes the screen to be displayed at 25% size. 

50% Causes the screen to be displayed at 50% size. 

100% 

200% 

400% 

Causes the screen to be displayed at 100% size. 

Causes the screen to be displayed at 200% size. 

Causes the screen to be displayed at 400% size. 
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Mark Printable Addresses 

Allows you to specify that the selected addresses ,in the List window will 

be visible, or printable, in the Layout window. The check: mark: to the left of the 

address in the List window signifies that the address is printable. Alternatively, 

just clicking on the check mark toggles the printable/not printable state of the 

address. 

This feature is useful in conjunction with Select By Example. Suppose you 

wanted to only print out all of the addresses from California. First choose Select 

AB, then Clear Printable Addresses, and then Select By Example. Type CA in 

the State field and click the Select button. The List window will have all of the 

California addresses highlighted. At this point, choose Mark Printable Ad­

dresses. Now only these marked, printable, California addresses will appear in 

the Layout window, ready to be printed. 

Unmark Printable Addresses 

Allows you to specify that the selected addresses in the List window will 

be not visible, or not printable, in the Layout window. The absence of a check 

mark to the left of the address in the List window signifies that the address is 

not printable. 

Mark Return Address 

Allows you to specify which one address wm be the return address for 

each label or envelope in the Layout window. In order for this option to be ac­

tive you must have one, and only one, address selected in the list window. Se­

lect the desired address, and then pull down the List menu and choose 'Mark 

Return Address'. Upon performing this action, the address wm appear red, but 

only in the List window, to signify it is the relum address. 

Note: Choosing a return address has the side effect of having a label with the 

same from and to address. You can avoid this by selecting the return address 

from the list window, and then unmarking it as a printable address. 
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Elements 

This term is used in the layout window. Each label/cell displayed in your layout 

window may contain any and all of the following elements: 

Address - A complete address is comprised of fields l - 14, as mentioned earlier. 

However, you may set up your layout so that some fields won't appear in the 

layout window, and thus won't be printed. 

Return Address - You may designate one of your database entries to be a return 

address. 

Postal Bar Code - Generated by AFS per user request. 

Picture 1 - The first picture you paste into the layout window. 

Picture 2 - The second picture you paste into the layout window. 

Picture 3 - The third picture you paste into the layout window. 
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Change list Sorting Order ... 

(2) First Mame 
(3) Address 1 
m Address 2 
(5) Address 3 
(6) CitM 
(7) State 
(8) ZIP 
(9) Country 

(1~) Phone 1 
(11) Phm 2 
(12) Header 
(13) Title 

[]Pasta! Eu ik San 

{) Up Five 

0 UpOne 

{)' Down One 

-0- Down Five 

( Cancel ) 

( Sort ) 

Reference 

Figure 15. Change the sort order definition and perform sorts from this window. 

Additionally, two other buttons and one check box are available from the change 

Ust Sorting Order window: 

Sort - Once you have finished rearranging the sort order list, and are ready to 

actually sort the list, press the 'Sort' button located at the bottom right hand of 

the window. 

Cancel - Exits the window with no alterations being made to the sorting order, 

or to the list 

Postal Bulk Sort - This check box will only become active when the ZIP field is 

the first one on the sort list. This is because the list must be sorted by zip in or­

der for AFS to perform a Postal Bulk Sort If you check this box then AFS will 

perform a postal bulk sort when you press the 'Sort' button. Please see your lo­

cal United States Postal Office for more details regarding bulk sorts, they have 

requirements and guidelines which must be met. Also note that a postal bulk sort 

may take some time. 

Note: Sorting your list by a new sort order will cause the list window to list 

fields in the new sort order. 
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Edit Address 

Brings up the List Editor, where the eptry currently selected in the list 

window will be displayed. You can then modify any of the fields. See Insert 

New Address for details on navigating in the List Editor window, as well as de­

scriptions on the buttons available. Once finished making changes you must 

press the Change button in order for the List window to show the new changes. 

Note: Another way to edit an address is to double click on the address in the 

List window. This win also bring up the List Editor window. 

Edit Return Address 

Brings up the List Editor, where the currently designated return address. 

will show up. You may make any desired changes and then press the 'Change' 

button. See Insert New Address for details on navigating in the List Editor win­

dow, as wen as descriptions on the buttons available. 

Sort ... 

Allows you to change the order in which AFS displays the addresses in 

the List and Layout windows. Choosing this option displays a dialog box with 

a scrollable list of the fifteen address field names on the left hand side. The or­

der of the field names represents the order in which the fields are currently 

sorted. To change the sort order you begin by selecting the field whose order 

you want to change. You can then use one of five buttons to move the field up 

or down in the list: 

Up five - Causes the currently selected field on the list to move up five spaces. 

Up one - Causes the currently selected field on the list to move up one space. 

Down one - Causes the currently selected field on the list to move down one 

space. 

Down five - Causes the currently selected field on the list to move down five 

spaces. 
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File Menu 

New 

Displays a dialog box where you can choose to begin a new address data­

base List or a new page Layout template. 

Open"°' 
Displays a standard file dialog box allowing you to choose a List or a 

Layout file to open. 

Close 

Closes the front most window. 

Save 

Saves the current List or Layout session, depending on which of the two 

windows is front most 

Save As ... 

Saves the current List or Layout session, depending on which of the two 

windows is front most, allowing you to specify a new file name. 

Import ... 

Displays a standard file dialog box, prompting you to choose a file to im­

port into the current List 

Export ... 

Displays a standard file dialog, asking you to write out, or export, the 

List to an ASCII text file. 

Page Setup ... 

Displays a window prompting you to specify the page size in the Layout 

window along with other page options. 

PrinL. 

Prints the contents of the Layout window. 
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Eight buttons are present at the right bottom of this window: 

Change - This will not be active since you are entering a new entry, not chang­

ing a previously existing one. 

Add - Enters the data you've typed into the List window, and clears all the fields 

in the List Editor so you may make another entry. 

Clear - Clears all the fields/data you've just entered, so you can start over with 

this one entry. 

Cancel - Causes the List Editor window to close, and no new entries to be made 

to the List Editor window. 

Moves up one entry in the List window, and displays Hs 

information in the List Editor window. This is relative to 

the currently selected entry in the List window. Note that 

after entering a new address, it is inserted at the bottom of 

the list and this address becomes the currently selected en­

try. 

Moves down one entry in the List window, and displays its 

information in the List Editor window. This is relative to 

the currently selected entry in the List window. Note that 

after entering a new address, it is inserted at the bottom of 

the list and this address becomes the currently selected en­

try. 

Moves up to the top of the List window, and makes the 

first entry the selected entry. 

Moves down to the bottom of the List window, and makes 

the last entry the selected entry. 
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Windows Menu 

This menu contains a list of an windows currently open in AFS. Choos­

ing one of the windows brings it to the front. 

List Menu 

Insert New Address 

After choosing this item from the menu, the List Editor window appears. 

This window al.lows you to enter all the data for a new entry. Each field can 

contain up to 200 characters, except for the Memo field which can hold up to 

65,000 characters. 

~D list Editor 

Header Memo 
First/ Lost J 

Title I Compon!J J 
Address 1 
Address 2 
Address 3 

City I State I Oo( )( ) Zip/ Countr11 J l:hill\\l~ Add 

Phone1/2 I 0~( Clear )( Cancel ) 

Figure 14. AFS is ready for a new address to be typed and entered. 

To navigate through the fields you can use lhe following: 

Tab - Pressing the Tab key moves to the next field. 

Apple-Tab - Pressing these two keys in combination moves the cursor to the 

previous field. 

Mouse - You can move the arrow to the desired location and click there, and the 

cursor will now be positioned at this new location. 
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Quit 

Quits AFS back to the Finder. 

Edit Menu 

Undo 

Is not implemented within AFS. 

Cut 

Cuts the selected item to the clipboard. 

Copy 

Copies the selected item to the clipboard. 

Paste 

Pastes the contents of the clipboard into either the List window, the List 

Editor window, or the Layout window, depending on what type of item it is 

pasting. 

Clear 

Clears, or deletes the selected item. 

Select All 

Selects all items in a window. 

Select By Example 

Displays a dialog window allowing you to select only certain addresses 

in the List window that match selection criteria you specify. 

Find ... 

Displays a dialog window allowing you to find and select an address in 

the List window matching certain criteria. 

Show Clipboard 

Displays the clipboard window and its contents, 
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Windows Menu 

Choosing a window name from this menu makes the window front most 

List Menu 

Insert New Address 

Makes the List editor window visible and front most so that you can enter 

a new address into the List window. 

Edit Address 

Allows you to edit the one selected address in the List window by dis­

playing the address in the List editor window. 

Edit Return Address 

Allows you to edit the return address in the List window by displaying 

the return address in the List editor window. 

SorL 

Allows you to sort your data.base, and modify the sorting order if desired. 

Mark Printable Addresses 

Marks the currently selected addresses in the List window and makes 

them visible/printable in the Layout window. 

Unmark Printable Addresses 

Umnarks the currently selected addresses in the List window . These ad­

dresses will no longer appear in the Layout window, and will therefore not be 

printable. 

Mark Return Address 

Makes the currently selected address in the List window to be the return 

address for each label or envelope in the Layout window. 

C-4 

Reference 

Edit Found Address - When checked, will cause the List Editor window to ap­

pear containing any found entry. If no matches are found, an alert infonning 

you of this event will appear. You must then press the Continue button in this 

alert to return you to the Find window. 

Search Only Name Fields - When checked, causes AFS to only search for a 

match in only the First Name and Last Name field. For example, if you have 

this box checked and you have typed in 'Washington', only entries whose first 

name or last name contains 'Washington' will be found. An entry that has 

'Washington Street' for an address or City will not be found. 

Additionally, there are two buttons on the bottom of the window: 

Find From Beginning - The first time the Find window comes open, and once 

you have typed text to find, this button becomes active. Pressing this button 

causes AFS to begin its search, starting at the very first entry. 

Fi.nd Next - This button becomes active only after the first match has been 

found. Pressing this button causes AFS to continue its search, starting at the en­

try where it last found a match. 

Note: You may abort this function by dicking on the close box located at the 

top left corner of the Find window, 

Show Clipboard 

Displays the clipboard window and its contents. 

E-15 



Example 3. To select all addresses with a last name of Smith and a state of FL. 

1. From the List menu, choose 'Select By Example' 

2. Type 'Smith' in the Last Name field. 

3. Type 'FL' in the sate field. 

3. Press the 'Select' button. 

Find ... 

Displays a dialog allowing you to find and select an address in the List 

window matching certain criteria. This window contains a field where you type 

the desired item to be found, and four check boxes: 

Find 
Text to find: 

D Case Sensitive D Match Fields Exactly 
D Edit Found Rddrm D Search Only Name Fields 

( Find From Beginning ) ( find Mext ) 

Figure 13. The Find dialog. 

Case Sensitive - If this box is checked, and you type in 'McKenney', AFS will 

not find entries such as 'Mckenney' or 'mcKenney' or 'mckenney'. Only exact 

matches will be found. 

Match Fields Exactly - If this box is checked, and you type in 'Bobby', AFS 

will find entries that contain a field with 'Bobby' in them, and nothing else. If 

an entry has 'Bobby Joe' or 'Bobby M' for a first name, it will not be found. 

Note however, that unless the Case Sensitive box is checked, then a first name 

of 'bobby' or 'boBBy' would also be found. 
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Unmark Return Address 

. Causes the currently selected Return Address to no longer be used. as 

such, and it becomes a regular address. 

list Info ... 

Displays a dialog box with various statistics about the List, such as size. 

View Menu 

25% 

50% 

100% 

200% 

400% 

Causes the screen to be displayed at 25% size. 

Causes the screen to be displayed at 50% size. 

Causes tbe screen to be displayed at 100% size. 

Causes the screen to be displayed at 200% size. 

Causes the screen to be displayed at 400% size. 

Go To Page ... 

Displays a dialog window that lets you specify a page number to view. 

Cells Menu 

Set Cell Dimensions ... 

Displays a dialog box allowing you to divide the Layout's pages into la­

bels, or cells. 

Set Left and Top Margins ... 

Displays a dialog box to adjust the margins between the cells and the left 

and top edges of the page. 

Show Cell Boundaries 

This option, when checked, displays all of the cell boundaries in the Lay­

out window as light green rectangles for easier viewing. 

Clip Elements to Boundaries 

This option, when checked, clips off any items that are overflowing the 

size of your cell/label, and adjusts the display to show only what is printed on 

the cell/labeL 
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Cells Go Left to Right 

This option, when checked, arranges the List's addresses so that they pro-: 

ceed from left to right, and then top to bottom along the page. 

Cells Go Top to Bottom 

This option, when checked, arranges the List's addresses so that they pro­

ceed from top to bottom, and then left to right along the page. 

Elements Menu 

Addresses 

This item, when checked, displays the List's addresses in the Layout win-

dow. 

Return Address 

This item, when checked, displays the List's one return address in every 

cell, in addition to the normal List address. 

Postal Bar Code 

This item, when checked, displays a postal bar code in every cell that bas 

an United States address with a ZIP code. 

Picture #1 

This item, when checked, displays picture #1 in each cell. 

Picture #2 

This item, when checked, displays picture #2 in each celL 

Picture #3 

This Hem, when checked, displays picture #3 in each cell. 

Scale Pictures 

Brings up a dialog window I.hat allows you to scale the horizontal and 

vertical size of your picture, preview the results, and either apply or cancel. 
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9. Uncheck the 'Clear List Selections' box, since we do not want to lose the 

Florida.addresses we just had selected. 

10. Press the 'Select' button. 

11. Now all Florida and New York addresses will be selected. To mark only 

these addresses for printing, from the List menu choose 'Mark Printable Ad­

dresses' 

Wildcards 

The Select Addresses by Example window also accepts wildcards. Wildcards 

extend your flexibility to select data. The wildcard indicator for AFS is the aster­

isk,* . You can think of the asterisk as meaning 'anything'. The concept of 

wildcards is easier to explain by way of examples. 

Example 1. To select all people whose last names contain "kay" 

L From the List menu, choose 'Select By Example' 

2. Type *kay* in the Last Name field. 

3. Press the 'Select' button. 

This would select names such as: Mckay, Kay, Milkayd, and Kayfield. The aster­

isks before and after 'kay' signifies that anything may precede and follow the 

letters 'kay'. 

Example 2. To select all first names that begin with 'Chris' 

1. From the List menu, choose 'Select By Example' 

2. Type 'Chris*' in the Last Name field. 

3. Press the 'Select' button. 

Type 'Chris*' in the First name field. This would select names such as 'Christo­

pher', 'Christina', 'Chrissy', and 'Chris'. However, a name such as 'McChris' 

would not be selected. 
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. Example 1. To select all addresses which are from California 

1. From the Edit m.enu, choose 'Select By Example' 

2. In the state field, type 'CA' 

3. Press the 'Select' button. 

Nole that in this case anything that was previously selected in the List window 

will still be selected in addition to all California addresses. 

Example 2. To select everyone in Florida and New York then these are the 

steps you would take: 

1. From the Edit menu, choose 'Select By Example.' 

2. In the State field, type 'FL' 

3. If the 'Clear List Selections' box is not checked, check it. 

4. Press the 'Select' button. 

5. From the Edit menu, choose 'Select By Example.' 

6. In the State field, type 'NY' 

7. Uncheck the 'Clear List Selections' box, since we do not want to lose the 

Florida addresses we just had selected. 

8. Press the 'Select' button. 

9. Now all Florida and New York addresses will be selected. 

Example 3. This is a step further from the last example, in that not only do we 

want all the Florida and New York addresses selected, but we also want to have 

so those are the only labels that will print. 

1. From the Edit menu, choose 'Select All' 

2. From the List menu, choose 'Unmark Printable Addresses' 

3. From the Edit menu, choose 'Select By Example.' 

4. In the State field, type 'FL' 

5. If the 'Clear List Selections' box is not checked, check it. 

6. Press the 'Select' button. 

7. From the Edit menu, choose 'Select By Example.' 

8. In the State field, type 'NY' 
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Address Menu 

Choose Font... 

This displays a dialog box allowing you to change the font of the selected 

List address or return address in the Layout window. 

Display as UPPERCASE 

This option, when checked, displays all addresses as uppercase. 

Display ZIP with +4 

This option, when checked, displays all United States addresses' ZIP 

codes with the +4 extension if there is not already a +4 extension present 

The following menu items' field names correspond to the fields in every 

address. If the menu item field name is checked, then the field will be displayed 

within the address. If not checked, then it will be omitted. 

Header 

First Name 

Last Name 

Title 

Company 

Address 1 

Address2 

Address3 

City 

State 

Zip 

Country 

Phone 1 

Phone2 
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Select All 

Selects all items in a window, l~ke all addresses in the List window, or all 

elements in the Layout window. 

Select Addresses By Example 

The Select Addresses By Example dialog is identical to the list editor 

window, in that an the fields are displayed. In addition to these fields the dialog 

also contains a Cancel button, a Select button and a Clear List Selections 

check box: 

Select Addresses b~ Example . ., 

Heed er 
First I Last 

HU e I Company 
Addrm 1 
Address 2 
Address 3 

City/ State 
ZIP I Country 

Phm1/2 

I 
Memo 

I 

I 
l 
I 

121 Clear list Selections 

( Cancel ) ( Select ) 

Figure 12. The Select Addresses By Example dialog. 

Cancel - Pressing this button exits the Select Addresses by Example window 

with no changes being made to selected or unselected addresses in the list win­

dow. 

Select - Proceeds to perform the selection. 

Clear List Selections checkbox - if this box is checked, then all selections in the 

List window will be cleared before the selection begins. This box is checked by 

default, but you may deselect it by clicking on the box. If this option is disabled, 

the results of the selection, along with anything else that was previously se­

lected, will then be selected. 
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Print ... 

Prints the entire contents of the Layout windo.w. 

Quit 

Quits AFS back to the Finder. 

Edit Menu 

Undo 

Is not implemented within AFS. 

Cut 

Cuts the selected item to the clipboard, whether it be a selected address 

or addresses in the List window, a small piece of text in the list editor window, 

or a picture in the Layout window. 

Copy 

Makes a copy of the selected item and puts it in the clipboard. 

Paste 

Pastes the contents of the clipboard into the List window if the contents 

are a previously Cul/Copied address or addresses. If the contents are small 

pieces of text, it can be pasted into the list editor window. If the contents are a 

picture, it can be pasted inlo the Layoul window. You can copy pictures from 

graphics programs to paste into AFS. You can also copy text from word proces­

sors to paste within AFS. 

Clear 

Clears, or deletes, a selected item, whether it be an address, a small piece 

of text, or a picture. 
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This section of the manual will give you a step by step tutorial on using many of 

the functions in AFS. f'he tutorial folder that was installed along with the AFS 

application contains some of the files we'll be using. 

Our tutorial scenario is as follows: Susan uses AFS to keep a list of all her 

friends and families' mailing address. She uses the memo field to record each 

person's birthday. She does this in a standard way, so it is easy to search by. 

Examples of her memo fields: 

Bday Jan 10 

BdayDec 9 

Bday Aug 10 

Susan sorts her list by last name so it is listed alphabetically by last name. Susan 

prints out her entire list when sending out invitations for the annual picnic party 

and for sending out 'Happy New Year' cards. At the end of each month she 

prints out labels to send out birthday cards to those people who have birthdays 

the following month. 

Tutorial Example A 

This example will familiarize you with the List Editor and the List window. 

1. Launch AFS by double clicking on its icon. 

2. We will now open an existing list file from the Tutorial folder. From the File 

menu choose 'Open'. Go to the location where you instructed AFS to be in­

stalled and find the folder AFS.Folder. Open this folder and inside you wiH find 

a folder named 'AFS.Tutorial'. Now open the AFS.Tutorial folder and inside 

you will find a file named ListA. Open this file. 

3. The list window will now display the file you have just opened. Familiarize 

yourself with this window by scrolling through it both horizontally and verti­

cally. Notice the field headers near the top of the window. Also notice the check 

marks on the left side of the window. 

4. Susan just became an aunt and she wants to add her new niece's name and 
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If you have an lmageWriter or dot-matrix printer ... 

For an Image Writer or other dot-matrix type printer, there are more options to 

observe and be aware of. 

1. Examine the box/container that your labels are packaged in and look for page 

and label size information. If the box does not provide the necessary information 

you will have to do some measuring yourself. 

2. When choosing a Paper type, if you cannot find an exact match, then choose a 

match with the correct height for the label sheet The width can be wider than 

your actual label sheet For example, if your label sheet is 2 5/8" wide by 12" 

tall, you may choose the page size for 8 1/2" wide by 12" tall. 

Note: Most label sheets designed for dot-matrix printers will be a multiple of 

12" in height thus choosing an 8 1/2" by 12" paper size will be appropriate for 

99% of your labeling needs. This is the default for Image Writers. 

3. We suggest you check the No Vertical Gaps option for most label sheets so 

that the full height of the sheet is printable. 

Note: The dialog window from where you choose your page setup is NOT part 

of AFS. Rather, the printer driver, which is located in your boot disk's System/ 

Drivers folder, is entirely responsible for the page sizes that are presented. If 

there isn't a page size which exactly matches the label forms that you own, you 

will have to either buy an appropriate printer driver from a third party, like 

Vitesse or SevenHills, or choose a page size which fits the best. The latter op­

tion should work in all cases. 

Note: When using fanfold labels we recommend you select 'Intl Fanfold' instead 

of 'European A4', because European A4 is not exactly 12 inches in height, 

which will eventually cause your addresses to print off the labels. 
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The 'Export' dialog has two additional check boxes which control the export 

parameters: 

Tabs between fields, Returns between records - puts tabs between fields and 

returns between records. Check this box if you will be using the exported file 

with other databases 

Returns between fields and records - puts returns between fields and records. 

Make sure this box is checked if you will be using the exported file with word 

processors. 

Page Setup ... 

Displays a dialog prompting you to specify the page size in the Layout window 

along with other page options. Make your selections and press the OK button to 

continue. 

This feature corresponds exactly to the two large rectangles you see in the Lay­

out window. The outer red rectangle is the physical size of the page while the 

inner, dark green rectangle is the total printable area within the paper. 

Changing the page size will almost always require that you modify the number 

or labels/cells to a page, which is selected from the Set Cell Dimensions ... 

menu item. It is important that the page size you specify exactly matches the 

page size of labels you intend to print 

If you have a laser printer ... 

Since a laser printer only supports two page sizes, 8 1/2" by 11" or 8 1/2" by 

14", any labels you purchase will come in a sheet that is either letter or legal 

size. If you change from one to the other size, you might have to change the 

number of labels/cells to a page. See the Set Cell Dimensions ... menu descrip­

tion. 
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birth date to the list, so let's do that now. From the List menu choose 'Insert 

New Address'. The List Editor w.indow will be displayed next. Notice all the 

fields you have to work with, and the buttons available from this window. 

5. Next we will enter data for some of the fields. When you are done with one 

field you can press the Tab key to proceed to the next one, or you can always 

use the mouse to reposition your cursor at any location. Enter the following in-

formation. 

Field Name Information to enter 

Header <none> 

First Name Chelsea 

Last Name Williams 

Title <none> 

Company <none> 

Address 1 123 Washington Ave 

Address 2 <none> 

Address 3 <none> 

City Pittsburgh 

State PA 
Zip 15076 

Country <none> 

Phone 1 <none> 

Phone 2 <none> 

Memo Bday Nov 15 
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ED list Editor 

Header Hl!lllo 

First I Lost Chelsea lWil lillllls Bda!I Hov 15 ~ 
Tit I e I Compan~ 1 

Address 1 123 Washington Rve 
Address 2 
Address 3 '{} 

City I State Pittsburgh jPA 
Oo( )( ) Zip I Countr~ 15076 J Chu~~~ Add 

Phone 1 / 2 l 0~( Clear )( Cancel ) 

Figure Tl. List Editor window with all fields filled in. 

6. When you're finished entering all the infonnation press the 'Add' button. 

Now let's bring the List window to the front and look at where our new entry is. 

Perfonn either A or B to bring the List window to lhe front 

A. Click on the List window. 

or 

B. Pull down the 'Windows' menu and select 1..istA' 

7. Notice the last entry in the List window. Notice that it is hHited and that it is 

the entry you've just added. AFS places new entries at the end of the list, which 

is the last entry in the List window and also selects this last entry. 

lost Home 
1 Thompson 
1 Thornton, RN 
f Zoles 
" Ziebert 

listA 
Rddrm 1 Address 2 
15223 W 64th Tmo 
60 Medical Center 
3~35 West Market! 
11050 Cooleridg~ I 

Address 3 

Figure T2. AFS hilites a new entry in the List window. 

D-4 

Reference 
Exporl,.. 

Use this to export your AFS file to.an ASCII text me. This file could 

then be imported into an Apple Works file. After choosing 'Export ... ' AFS dis­

plays the standard put dialog where you can name the file to be exported, and 

also find a location for it. Upon pressing the Save button, AFS wm display a 

window that lists each AFS field along with a checkbox. See Figure 11. 

fie Ids to Import or Export 

l8l Header 
l8l First Hame 
[8]Lost Home 
18]Title 
181 Company 
181Address1 
[8lAddrm 2 
lE]Address 3 

[8J Cit~ 
[8l State 
[8lm 
18] Countru 
[8J Phone 1 
[8l Phone 2 
OMemo 

Formatting (export onh) 
®Tabs between fields, Returns between mords 
0 Returns between fields ond records 

( Cancel ) ( OK ) 

Figure 1 L AFS displays this window when you attempt to save a file for export. 

If a check is next to the field name, then that field will be exported. If there is no 

check, then that field will be skipped when exporting. By default all boxes will 

be checked except for the Memo field. You may deselect any of the checked 

. fields by dicking on the check box, thus making the check disappear. When 

done making your selections press the OK button and AFS will export the file. 

Note: It is not recommended that you export the Memo field. This is because the 

Memo field can contain carriage returns and/or tabs which can cause undesired 

results if the file is to be imported in the future. If you are careful not to put re­

turns/tabs in the Memo field, then there is no problem. 
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Once you match up the fields and are ready to import the file, you can save the 

field mapp.ing information as a template for later use. To do this, press the 

Save ... button on the bottom of the window. This will cause the standard save 

file dialog to appear allowing you to name the template, choose an appropriate 

location, and save it. Saving this template is very useful if you will be importing 

more than one AW file that has the same field names and orders, or perhaps im­

porting the same file a second time. Talce a quick glance to verify that the fields 

are matched correctly. Then click Import. AFS proceeds to import the file and 

display it in the list window. 

Importing an ASCII text file 

If the file is ASCII text, AFS wiU display.a window that lists each AFS field 

along with a checkbox. By default, all boxes will be checked except for the 

'Memo' field. You may deselect any of the checked fields by clicking on the 

check box, thus toggling the check mark. When you export a file to be later im­

ported by AFS you must keep the fields in the same order that AFS displays in 

the List Editor window. It is OK if you are exporting a file that is missing one 

or more of the fields contained in AFS; this is where the checkboxes come in 

handy. Uncheck any AFS field that is not contained in your file to be imported 

and AFS will leave that field blank. 

Fields to import or Export 

[8l Header 
[81 First Hmu 
r;81 last Name 
[81 Title 
l'.81 Company 
t8]Addms 1 
l2l Address 2 
181 Address 3 

181 City 
[81 State 
181m 
18.1 Countrg 
181Phon~1 
1'81Phone2 
0Memo 

formatting (export onh) 
i:!,1 fobs tiet11t•Ni liel<ls, R~turns bet~ii~en mcrds 
()Returns betNm fal ifs und imrds 

( Cancel ) OK 

Figure 10. If an item is checked, then it signifies 

that it is contained in the file to be imported, 
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8. Next we will select an entry from the List window. Scroll through the List 

window and look for an entry with a last name of Horton and a first name of 

Kimberly. When you see it position your cursor anywhere on that entry/row, 

except on the extreme left of the entry where the check mark appears, and 

double click. You wm see the List Editor window appear with the chosen entry 

being displayed in the appropriate fields. 

9. This person has just moved and we need to change the address. Place your 

cursor at the beginning of the field Address!, drag the mouse to select an the 

text there then press I.he delete key to delete the contents. Now type '107 Walnut 

Tree Rd' in the Address! field. 

10. Any changes you malce in the List Editor window does not automatically get 

recorded. You must now press the 'Change' button for the changes to be re­

corded. 

11. Now notice the four arrows present in the List Editor window. These arrows 

al.low you to scroll up and down through the list, with each entry being dis­

played in the List Editor window as you scroll. Experiment with pressing these 

buttons to see the results. 

12. Now lets malce a change to the entry whose last name is 'Ashley'. As we 

said, the list is sorted (therefore displayed) by the Last name field, in increasing 

order. We therefore would expect to see a last name of Ashley towards the top 

of the list To quickly go to the top of U1e list, and have that ent.ry displayed in 

the List Editor window, press the 'move to the top' button (see Figure T3.) 

Figure T3. From left to right these buttons will move up one, move down one, 

move to the top, move to the bottom. 
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13. Notice the last name entry that appears at the very top of the list window is 

'Amieka'. We wanted Ashley, so dick on the 'move down one' button to go 

down one entry. Now the last name reads Ashley. Change the Address1 field so 

that it reads '8701 Apple Lane'. To record the change, press the 'Change' but­

ton. If you had not pressed the 'Change' button, and used one of the arrows to 

scroll to another entry, you would have lost your changes. 

14. Susan received news that one of her relatives has passed away, and she 

wants to remove this entry from her list so that she does not accidentally send a 

birthday card to that person next year. We will show you how to easily do this 

from the List window. Click on the list window to bring it to the front Now 

scroll through H while looking for a last name of Zales and a first name of 

Myron. When you find it, click on it once to select it, and then press the delete 

key on your keyboard. This wm delete the entry. Alternatively, instead of press­

ing the delete key you could have chosen 'Clear' from the Edit menu. 

8. Let's save the file with all the new changes. From the File menu choose 

'Save'. Your file will be saved immediately. To quit AFS choose 'Quit' from 

the File menu. 

Tutorial Example B 

This example will familiarize you with the Sort function available while in the 

List window. 

AFS sorts lists on demand. This simply means that if you want to make sure 

your list is sorted you musl specifically tell AFS to do so. If your list is sorted 

and you add a new entry, this entry is added to the bottom of the list, which 

more than likely will cause your list not be sorted anymore. By adding a new 

entry to her list, Susan realizes that it is no longer in order. However, she has 

decided that she would actually prefer to sort the list by First Name and second­

arily by State. We will show you how to sort the list 
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Import App leWorks Database Fil es ... m Records 
AppleWorks ---"' 

( First Home 
(3) PHOHE Lost Name 
(4) FJmHAHE Title 
(5) LAST NAME Compons 
(6) - Address 1 
(7) ADDRESS Address 2 
m cm Addrm 3 
(9) ST Cit~ 

(10) ZIP State -0-
PROFILE ! Header ~ 

( Cancel )( Open ... )( Save ... ) ( Import ) 

Figure 9a. This dialog allows you to define how 

Apple Works fields are to be imported into an 

AFS list. 

Cooipony 
Address 1 

(5) LAST HRME Address 2 

(6) - Address 3 
(7) ADDRESS Cit~ 
mcm State 
(9) ST ZIP cm m Country 

FIRST MAHE Phone 1 
Phone 2 

( Cancel )( Open ... ) v mport 

Figure 9b. The first name fields are being matched up. 
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Note: In order for the Import menu item to be active you must have a list 

file open. This list file can be one iliat was just created and contains no i~forma­

tion. However, if you have a Hst file currently open and then you proceed to Im­

port another file, the file being imported wm be appended to the me currently 

displayed in the list window. 

Importing an AFS List 

1) If the file is an AFS list, then there will be no further prompts. The contents of 

the imported file are appended at the end of the List currently open in AFS. All 

entries in the newly imported file will be selected, and marked as printable. 

Importing an AppleWorks database 

2) If the file is an Apple Works database, the dialog window shown in figure 9 

will appear. The list on the left contains the field names of the Apple Works file. 

The list on the right contains the field names available in AFS. More than likely, 

the fields will not be matched up correctly, since AFS matches the first field in 

the Apple Works file with the first field in AFS and so on. 

To change the matching arrangement you must first select one of the Apple Works 

entries shown in the scrollable list by dicking on it It will become hilited. Next, 

notice the pop-up menu below and to the right of this scrollable window. It will 

have the name of the AFS field that is currently matched with the selected AW 

field. To change the AFS field, press and hold down the mouse button. A menu 

listing all AFS fields will appear. Drag the mouse so that the arrow moves up and 

down this menu, and you will be able to see all the AFS fields. Once you have the 

arrow on the desired AFS field, and it is hilited, you can release the mouse button 

and your new selection will have been made. Verify the change on the scrollable 

window. 

You may now select the next AW field you want mapped differently and repeat 

the process. Note that there is also a <None> option for AFS fields. By choosing 

<None> you wiU effectively eliminate the AW field from being imported into the 

AFS list file. 
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1. Launch AFS and open ListA. Now from the List menu choose 'Sort'. You 

will see the following window come up on your screen. 

Change List Sorting Order ... 

(2) First Home 
(3) Address 1 
(~) Address 2 
(5) Addri!ss 3 
(6) City 
(7) State 
mm 
(9) Country 

(10) Phone 1 
(11) Phone 2 
(12) Header 
(13) litl!! 

D Postal Bulk son 

"(}Up five 

0 Up One 
9 Down One 

{)Down Five 

( Cancel ) 

( Sort ) 

Figure T4. The Sort window. 

Notice the order of the field names in the scrollable window that appears in the 

left portion of the sort window. This is the order that is currently set up for AFS 

to sort in. That is, AFS sorts by Last Name, then by First Name, and so on. 

2. The first thing we must do is move the field 'First Name' to the top of the 

list Select the field name 'First Name' by clicking on it once. Now press the 

arrow button labeled 'Up One'. Notice that the field name has moved up one 

position, and is now the first one on the list. This is exactly what we wanted. 

Now we want the 'State' field to become the second one. Select the State field 

and then press the button labeled 'Up Five' to move it up five spaces. 
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Change List Sorting Order ... 

(1) First Heme -fr 

(3) Last me 
m Address 1 
(5) Address 2 
(6) Addrm3 
(7) City 
(8) ZIP 
(9) Country 

(10) Phone 1 
(11) Phone 2 
(12) Header 
(13) Title 

tJ Upfi11@ 

Q Up One 
0 Down One 

--!} Down Five 

( Cancel ) 

( Sort ) 

Figure TS. The sort window after the sorting order has been changed. 

3. Now we have set up how we want AFS to sort our list Press the 'Sort' button 

for the actual sort to take place. When AFS is done it will return you to the list 

window. Notice the column headers in the list window have changed positions. 

Scroll through the window to see the results of the sort. 

4. Susan has decided she preferred the old sorting method better. So, change the 

sorting order to the following and sort your list once more: 

Last Name 

First Name 

Addressl 

AAddress2 

Address3 

City 

State 

Zip 

Country 

Phonel 

Phone2 

Header 

Title 

Company 

Memo 
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When you have located the file you want to open, simply double click on it; or 

select it by clicking on it once, and then click on the Open button. This wiU 

open the AFS list or layout file, and display the infonnation in either the layout 

window, or the list window. 

Close 

Closes the front most window. If the window is a List or a Layout win­

dow, AFS wm ask you if you want to save your work before closing. 

Save 

Saves the current List or Layout session, depending on which of the two 

windows is front most It is important to note that the List and the Layout are 

saved separately. That is, you store your List in one file and your Layout in an­

other. This arrangement is so that you can have many different Layout tem­

plates for a single List. If this was a new file, you will be prompted to name it. 

At that point you may also place it in a different location. 

Save As ..• 

Same as Save, but allows you to specify a new file name. At that point 

you may also place it in a different location. 

Import"°. 

Displays a standard file dialog box, prompting you to choose a file to 

import into the current List. The types of files AFS will import are: 1) 

Apple Works Classic database, 2) AFS lists, and 3) ASCH text files. Theim­

ported file will be added to the current List and all of the imported addresses 

will be selected. AH entries in the newly imported file will be selected, and 

marked as printable. 
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New 

Displays a dialog box asking whether to begin a new address database 

List, a new page Layout template, or both. See figure 7. By default, both boxes 

are checked. If you do not wish to open both a List and a Layout, then uncheck 

the undesired item by clicking on it. The Cancel button allows you to exit the 

function without starting any new files. 

Start a new session ... 

l8l List 

( Cancel ) ( 

~ 
~ 

[;]Layout 

Hew ) 

Figure 7. Choose the type of new file desired from this window. 

Open ... 

Displays a standard file dialog box (see figure 8) allowing you to choose 

a List or a Layout file to open. 

Open which list or lo!}out? 
l:f) (iill AFS. v1.0 (ProOOS) 
l!flt!i:J')u1: J~'l.!.ll!!lll -fr ( Disks ) 

G;J Icons 

( Open ) 
( Close ) 

-0! ( Cancel ) 

Figure 8. The standard dialog for opening a me. 
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5. When you're done with the sort save your file and proceed to the next ex­

ample. 

Tutorial Example C 

This example will familiarize you with the Layout window, and also some new 

features from the List menu. In this example we assume you have an 

Image Writer printer. If you have another you can still go through the example. 

You must have completed Example A before proceeding with Example B. 

Background Information: It's the end of November and Susan wants to print out 

labels for people with December birthdays. The first thing she needs is a layout 

window. AFS provides you with templates for some of the more popular label 

sizes. Susan has gone to the office supply store and bought some A very labels 

#4241. These labels are actually meant to go on 3-1/2" floppy disks, but Susan 

likes to use them for her birthday mailings because they're much roomier than 

the usual address labels and she can put a nice birthday picture on her label. 

1. When you installed AFS you also installed a folder named 'Avery.Layouts'. 

Since Susan is using A very labels, she will check to see if a layout template for 

this label is included in iliat folder. From the File menu choose 'Open'. You 

must now locate the Avery.Layouts folder and open it Next open the file named 

'Image Writer'. A list of layout files will be displayed. Scroll through the list and 

find the file named 'A very .4241 '. Notice thal I.his is tl1e same number on 

Susan's box of labels. Select the file and open it. 

We muset up our page size now. From the File menu choose 'Page Setup'. For 

Paper Type choose Intl Fanfold ... .8'' x 12". For Reduction choose Full Size. For 

Height have both the No Vertical Gaps and the Vertical Condense boxes 

checked. Press the OK button. 

3. Next the layout file will display all of your entries in the labels. What is dis­

played in your layout file would be exactly what would get printed, but don't 

worry about how the layout looks. But wait!! The layout is IO pages long, it 
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includes an entries from List A - yet we only want to print labels for those 

people with birthdays in. December. We will take care of that in the next step. 

4. First, let's return to the List window. From the Windows menu choose 

'ListA'. TI1is brings up the List window. What we must do now is to select the 

desired birthdays and mark them for printing. Notice once again the check 

marks on the left side of each entry. Each check mark signifies that the corre­

sponding entry is 'marked' for printing. All of our entries have check marks by 

them, and that is why they are all included in the layout, because they're 'print­

able'. Take the following steps in order to get the results we want 

a. Select all the entries in the list window. Do this by choosing 'Select 

All' from the Edit menu. 

b. Now we will mark the entries as not printable. To do this pull down 

the List menu and select 'Unmark Printable Addresses'. Now notice that all of 

the check marks have disappeared. By using the Windows menu as shown be­

fore, take a look at the Layout window, named Avery.4241, and verify that 

there are no addresses there to be printed, and then return to the List window. 

c. We must now select all entries that have 'Bday Dec' in the memo 

field. From the Edit menu choose 'Select by Example' . The Select Addresses 

by Example window will appear. This is where you specify what addresses you 

want to select. Go to the memo field, and click there so that the cursor shows up 

in that field. Next, type '*Bday Dec*'. Yes, you must include an asterisk before 

and after the text to be found/selected. 

You can read '*Bday Dec*' as meaning 'anything, then Bday Dec, then any­

thing'. If we had simply entered 'Bday Dec', AFS would only find/select those 

entries that have exactly 'Bday Dec' in them, nothing more, nothing less. So if 

an entry contained a period after Dec then it would not. be found/selected. The 

asterisk is called a 'wildcard' and the reference section explains wildcards with 

more details. 
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Figure TI. Layout window after all pictures have been pasted 

and all elements have been arranged. 

13. That's it! You can now quit AFS and you're done with the Tutorial. We 

have not covered everything available in AFS with this Tutorial, but you should 

now have a good basic understanding of how things work. The Reference sec­

tion contains more information on the features of AFS, so be sure and look 

through it when you have an opportunity. 
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Now press the Select button. When AFS is done with the selection it will bring 

the List window to the front Be C3!eful not to click in the list window, since this 

would cause you to accidentally select the entry just clicked on, and you will 

lose the selections we've just made. Scroll all the way to the right so that the 

Memo field is showing. Now scroH up and down and notice that all entries wiili 

'Bday Dec' in the memo have been selected. 

d. Now we must mark all the selected fields as 'printable'. From the List 

menu choose 'Mark Printable Addresses'. Now go to the layout window and 

notice that the only addresses showing are those with 'Bday Dec' in the memo 

field. 

5. While the layout window is in the front, select Save As from the file menu 

and save your layout file as Bday.Layout, placing it in the AFS.Tutorial folder. 

Close the layout file. 

6. While we're at it, save the list file (do not rename it). 

7. Now we'U add a picture to our labels. Open the layout file 'AFS.Pict'. This 

file is located in the tutorial folder and it contains three pictures. The layout it­

self is not important; this file is solely so that you can copy one of the pictures 

there for use with this tutorial. Normally, you can use a program like 

AppleWorks GS or Platinum Paint to create pictures. 

When the AFS.Pic! file is displayed in the layout window you will see three pic­

tures shown in the label; a picture that says 'Happy Birthday!', a birthday cake, 

and a plain black border/rectangle. Select the 'Happy Birthday!' by clicking on 

it. You will see a gray rectangle appear around it. This signifies 1l1at it has been 

selected. From the Edit menu choose 'Copy'. Now close this layout file by 

clicking on the little close box at the top left corner of the window. 

8. Open the layout file Bday.Layout. From the Edit menu choose 'Paste'. You 

will see the 'Happy Birthday!' appear on the layout window. Don't worry that 

the entire 'Hayppy Birthday!' picture is not visible. We'll explain shortly. 
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Notice the green outlines in the layout page. These green outlines represent the 

size and position of the labels. It is your .choice whether you like to have the la­

bel outline showing or not. To see how this works, choose 'Show Cell Bound­

aries' from the Elements window. You have just toggled Show Cell Boundaries 

off, so they will not be displayed. Go back and toggle the cell boundaries back 

on so that we can see the outline of the label. 

Now also notice how our picture seems to disappear right where the label out­

line appears. The reason for this is that we have 'Clip Elements to Boundaries' 

toggled on in the Cells menu. This is a very helpful function because it shows us 

that our picture is falling off the edge of the label. From the Cells menu toggle 

'Clip Elements to Boundaries' off and observe the resulls in the layout window. 

Toggled it back on when you're done observing. 

Now select the address and, by dragging the mouse, move it to the lower portion 

of the 'label'. Next, select the 'Happy Birthday!' picture and drag it to just above 

the address. You should now be able to see the 'Happy Birthdday' picture in its 

entirety. 

9. Hmmm, there is still room on the label - let's add that birthday cake. 

a. First, save the Belay.Layout file. 

b. Next, open the AFS.Pict file. 

c. Select the birthday cake and copy it. 

d. Close the AFS.Pict file. 

e. Open the Bday.Layout file and paste the birthday cake there, 

f. Reposition your elements so that the cake is to the right of 

'Happy Birthday!' and the address is nicely centered underneath 

both pictures. See Figure T6. 

10. Well, the label looks real nice now, but if we could put that nice border 

around the address it would look extra special. Repeat steps 9a-9d, but copy and 

paste the border/rectangle instead of the birthday cake. You will notice that the 

border doesn't quite fit right We'll take care of that in the next step. 
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Figure T6. Layout window after the 'Happy Birthday!' and cake 

pictures have been pasted. 

11, The border should be selected by default, but if you accidentally deselected 

it, select it now. From the Elements menu choose 'Scale Picture'. Delete the 100 

shown in both the horizontal and vertical scaling and type in 75 for both. Press 

the Preview button and see what happens. Next, press the Apply button. AFS 

will scale the picture and return you to the layout window. Now reposition the 

border so H fits nicely around the address and it actually mimics some of those 

address labels you can purchase at the store. You might have to scroll down to 

see the rest of the label and position your elements properly. 

12. We're almost done. Save the layout file and print it by choosing 'Print' from 

the File menu. Of course, you won't have the proper labels in your printer but 

this will give you an idea of how things will look whe.n printed. 
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